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This chapter presents a brief introduction of 
Acer RDM and the special features that it 
offers.
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Welcome
Welcome to the Acer Remote Diagnostic Manager (RDM) — a server 
service program that offers remote server management functionality.  
It operates thru a local area network (LAN) to remotely monitor and 
analyze server condition via a remote RDM station.  This allows you to 
update system BIOS settings for the BIOS Console Redirection 
feature.  In case of system failures, Acer RDM automatically sends email 
to notify the system administrator.  This quick response feature 
minimizes system downtime thus effectively overcoming the distance 
barrier in remote server management.  

RDM components

RDM consists of two components:

• RDM station

RDM station is a standard PC system where the RDM software is 
installed.  It remotely monitors the RDM agent via LAN allowing  
administrators to view the status of the agent and resolve 
problems in the event of server failure. 

• RDM agent

RDM agent refers to a network server being monitored by the 
RDM station. 

Note:  Throughout this user’s guide, the words “RDM agent” and 
“server” are used interchangeably.
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Features
The following features explain how Acer RDM offers efficient server 
diagnostic service to reduce server downtime.

Remote management features
• Remotely manage RDM agent servers over LAN

• Remotely perform system diagnoses and services over LAN

• Allows automatic system reboot once a boot failure is detected

• Monitors and displays server status information1 and 
configuration, even in the event of server failure

• Automatically powers off the system when a system failure or 
abnormal processor temperature level is detected

• Automatically sends email notifications to the system 
administrator(s) when critical events occur 

• Allows remote server power on/off/reset the server from the Acer 
RDM station

Acer RDM station features
• Monitors the system boot sequence

• Allows remote updating of the system BIOS or changing of the 
CMOS setup

• Allows the system to boot normally or boot to a remote floppy 
disk

• Auto discover a server installed with an Acer RDM module

• Configures Acer RDM module NIC setting

• Selects type of critical events to trigger email notification

• View and clear event log

1 Server status information include those related to the model name, health 
log, critical event, CPU and memory information, temperature, voltage, CPU, 
memory critical event, as well as other server information.
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Accessing the online guide
You may also refer to the Acer Remote Diagnostic Manager online 
guide for more information.  To access the RDM online guide, from the 
RDM main window click Help then select Acer RDM Help.
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Technical assistance
For technical assistance on the installation of or questions concerning 
Acer RDM program, you can contact us at www.acer.com.
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This chapter gives step-by-step instructions on 
how to install the Acer RDM software.
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System requirements
Before you begin installation, make sure you have the following:

RDM station
• Intel Pentium II or higher processor

• Microsoft Windows 98, Windows Me, Windows NT Workstation 
4.0, Windows 2000 Professional or later operating system

• At least 16 MB random access memory (RAM)

• At least 15 MB free hard disk space

• Ethernet card 

RDM agent
• Intel Pentium II or higher processor

• MS-DOS v3.3 or later operating system 

• ASM (Advanced Server Manager) agent with RDM driver

• Ethernet card
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System installation

Note:  For any inquiries regarding Acer RDM installation, you can 
contact us at www.acer.com.

Installing the RDM station software

Important:  Before you proceed, make sure that the BMC board 
has been installed to the server. 

Installation procedures might vary, depending on your system’s 
operating system. 

To install Acer RDM on a Windows 2000 platform, follow these 
procedures:

1 Insert the Acer RDM installation CD into your computer’s CD-ROM 
drive.  The InstallShield Wizard appears on the screen. 

2 After configuring the InstallShield Wizard, the BMC board 
installation notice dialog box appears.  
The BMC board must be installed to make your server RDM-
enabled. 
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3 Click OK.  The Setup program welcome screen appears.

4 Click Next.  You will be requested to choose a destination directory 
for the software program.

You can choose to copy the program files in the default directory 
C:\Program Files\Acer Server Management Suite\RDM or you can 
choose another destination folder by clicking the Browse button.
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5 Click Next to copy the files in the defined directory.  The Select 
Program Folder window appears.  Select a folder from the list 
where the program files will be copied.   

6 Click Next to start the installation procedures. 
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When installation is completed the following message box 
appears.

7 Click Finish to exit setup.

Installing the RDM agent software

Important:  Before you proceed, make sure that you have already  
installed all necessary components for the RDM station. 

Note:  Before you install the RDM agent software, set up a 
network connection between the server and the local computer.  
Consult the server’s operating system manual for information on 
how to configure network setup. 

Follow these steps to install the RDM agent:

1 Copy the BMC IP configuration utility from the RDM station.  
Follow the steps below:

a Locate the RDM utility folder in the RDM station’s Program 
Files folder (for example C:\Program Files\Acer Server 
Management Suite\RDM\Utility).  The default folder is Utility.   
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b Double-click the Utility folder then copy the BMCIPCFG.exe 
command to a diskette. 

2 Insert the diskette to the server’s floppy drive. 

3 Reboot the server. 

4 After the server boots from the diskette drive, a prompt appears; 
A:\>

(where A: is the drive letter of the drive where you inserted the 
diskette)

type the following:

BMCIPCFG.EXE 

The server’s DHCP (Dynamic Host Configuration Protocol) 
automatically displays the RDM agent’s IP address.  

The default IP address is 192.168.224.222.  If you do not want to 
use this default IP address, click No then define your own IP 
address, Subnet mask and Gateway address.  

5 Select 8 to save your settings.

6 Run the BMCIPCFG.EXE program again to see if your setting is 
successful.

Uninstalling the RDM station software

To uninstall the Acer RDM station software on a Windows 2000 
platform, follow these procedures:

1 From the Control Panel window, double-click the Add/Remove 
Programs icon.  The Add/Remove Programs dialog box appears. 

2 Find the Acer Remote Diagnostic Manager entry and click the 
Remove button.  The Confirm File Deletion dialog box appears.

3 Click OK to remove all components.

4 Click Finish to exit.
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This chapter describes how to use the Acer RDM 
functions.  
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Launching Acer RDM 
If you choose the default program folder path C:\Program Files\Acer 
Server Management Suite\RDM during installation, a program shortcut 
is automatically added to the Windows  Start menu.

To launch Acer RDM:

1 Click on the Start menu, point to Programs then select Acer Server 
Management Suite.

2 Click Remote Diagnostic Manager.  
The Acer Remote Diagnostic Manager window appears.

Note:  The network folder is a system default root folder and thus 
cannot be deleted. 
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Acer RDM menu bar 
The Acer RDM menu bar includes the following:

• Server

• Setup

• Actions 

• View

• Help

Server

The Server menu consists of the following commands:

• Auto-Discovery 

By default, the Auto-Discovery command locates an RDM agent 
within the same subnet as that of the Acer RDM station.  This 
process may take a few seconds depending on the size of your 
network.  All discovered servers will be displayed on the left and 
right panel of the Acer RDM window.  You can select a server from 
the right panel then drag-and-drop it to the left panel for 
management.  
Right-clicking a server entry on the right panel of the Acer RDM 
window will display a pop-up menu consisting of the following 
commands: 

Commands Description

Add Server Adds a selected server to the left panel.

Add All Servers Adds all discovered servers to the left panel.

Delete Server Removes a selected server from the right panel.  
If the selected server already exists on the left 
panel, it will also be removed.

Delete All Servers Removes all the discovered servers from the 
right panel.  If the server already exist on the 
left panel, it will also be removed.
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For more details on adding or deleting a server from the RDM 
window, refer to page 40.

• Find subnet 

Finds Acer RDM-enabled servers within a specific subnet.   If you 
do not know the IP address of the server, you can specify the range 
of IP addresses from which Acer RDM will start and end its search.  
For example 192.168.1.1 - 192.168.1.254.  Acer RDM will start to 
send out a query packet to the first server in the IP address range; 
it will not continue to probe the next server until the response 
packet is returned or a timeout occurs.  

The find subnet command requires the following parameters:

For instructions on how to find a subnet, refer to page 42.

• Find specific IP

Finds Acer RDM-enabled servers based on a specific IP address. 

For details on finding a server based on a specific IP address, refer 
to page 43.

Add to Address Book Adds a selected server into the address book.  
For more information on the Address Book, see 
page 20.

Parameter Description

From The IP address from which Acer RDM will start 
its search.

To The IP address that marks the end point of the 
Acer RDM search.

Timeout Indicates the internal time after which Acer 
RDM will proceed to probe the next server in 
the specified IP address range.

Commands Description
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• Address Book

Use Address Book to maintain a list of Acer RDM-enabled server. 

The Address Book menu bar includes the following commands:

• Actions

• Edit

For details on configuring the Address Book, see page 44.

• Change server name

Modifies the name of the server.  When the login password is 
validated, you can change the server name. 

For detailed instructions on changing a server’s name, refer to 
page 47.

• Delete

Removes a managed server from the left panel of the Acer RDM 
window.  RDM will first disconnect a server before deleting it.  

Command Description

Save Saves a selected server to the Address Book.

Discovery Detects a selected server in the subnet.  If the 
server detected is a RDM-enabled server, it will 
appear on the left and right panel of the RDM 
window.

Close Closes the Address Book.

Command Description

Add Adds a selected server to the Address Book.

Modify Modifies the server list in the Address Book.

Delete Removes a selected server(s) entry from the 
Address Book.

Delete All Remove all server entries from the Address 
Book.
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• Delete All

Removes all managed servers from the left panel of the Acer RDM 
window.  RDM will first disconnect servers before deleting it.

• Refresh

Updates the health status of the servers listed on the left panel of 
the Acer RDM window.  The server status is indicated by the icons 
alongside each listed server.  

For details on updating the health status of a server, refer to page 
48.

• Exit

Closes the Acer RDM program.

Setup 

The Setup menu consists of the following commands:

Icon
Color/
Command

Description

Lock Acer RDM is not logged into the server.

Gray Server is in a power-off, unknown or not 
connected state.

Green Server is in a healthy state.

Yellow The server is in a warning condition.

Orange A critical error occurred in the server.

Red A non-recoverable error occurs in the server.
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• BMC NIC 

Configures the out-of-band NIC (network interface controller) of 
the server.  BMC NIC allows you to manage the LAN port and the 
NIC settings on the server.  

The BMC NIC command requires the following information:

For more information regarding the BMC NIC command, refer to  
page 49.

• E-Mail

Configures the SMTP (Simple Mail Transfer Protocol) server IP 
address, SMTP port, sender or recipient email address.  The quick 
response feature will not work properly if the SMTP server and 
port number is not provided in the email dialog box.  After setting 
up the email information and selecting the “Enable Email 
Notification” option in the Event Filter dialog box, the server will 
be able to send an email alert to the system administrator every 
time a critical system event is detected.

The E-Mail command requires the following information:

Option Description

Out-of-band IP 
Address

Retrieves a server’s IP address automatically 
from the server’s DHCP or you can manually 
enter server’s IP address, Subnet mask and 
Gateway IP address to connect to the network.

DNS Setting Retrieves a server’s DNS settings automatically 
from the server’s DHCP or you can manually 
enter the server’s primary and secondary DNS 
settings to connect to the network.

Field Description

SMTP Server The IP address of the SMTP server in the LAN.

SMTP Port The TCP/IP port of the SMTP server.

From Sender’s email address.
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For details on sending email notifications to the system 
administrator, refer to page 50.

• Security

Changes the password of a server.   For security reasons, the server 
password should not be left blank to prevent unauthorized access 
to the server.

For detailed instructions on configuring the server’s password, 
refer to page 52.

• Event Filter

Enables the E-Mail notification function of the server.  This 
function is disabled by default.  You have to enable it in order to 
receive email notification from the server whenever a system event 
or an error occurs.  If a system event or an error is detected in the 
managed server an alert will be sent to the system administrator.  
System events that may trigger this function includes:

To Recipient’s email address or administrator’s 
email address.  The Add button lets you include 
another recipient address.

Time Zone Set the local time zone for SMTP.  

Event type Description

Fan Fail The server’s CPU fan failed.

Voltage Critical The server’s voltage level is above the safe 
operation range. 

Voltage Not 
Recoverable

The server’s voltage level can not be restored 
to the safe operation range.

Temperature Critical The server’s CPU temperature has exceeded the  
threshold level setting. 

Temperature Not 
Recoverable

The server’s temperature cannot be restored to 
the threshold level setting. 

Intrusion An unauthorized user or hacker has broken 
into the server.

Field Description
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For detailed intructions on how to the enable email notification 
function, refer to page 51.

• Automatic System Recovery

Enables the Watchdog timer during the server’s BIOS POST and OS 
process.  Acer RDM allows you to select the type of action to be 
performed when system fails to boot.  The action commands 
include: power down, power cycle and reset.

CPU Internal Error An internal error occurred in the server’s CPU. 

DRAM Multi Bit Error An ECC (error-correcting code) multiple bit 
error is detected, which cannot be fixed. 

DRAM Single Bit 
Error

An ECC single bit error was corrected.

PCI Bus Error A PCI parity error or system error is detected.

BIOS POST error An error occured in the server during POST 
(power on self test) process.

DRAM Resize A multiple bit error occurred causing the 
memory size to decrease. 

Power or Reset 
Button Pressed

The server’s power or reset button has been 
activated. 

Watchdog Timeout The Watchdog timer detected a failure in the 
server’s BIOS POST and OS loading process. 

CPU Thermal Trip The server’s internal CPU temperature is too 
high.   A thermtrip (thermal trip) signal is 
issued and BIOS will log the event and identify 
the CPU which sends out the command. 

Event type Description
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The Automatic System Recovery command requires the following 
parameters:

Note:  The maximum value of both the BIOS POST and OS Load 
Timeout parameter is 100 minutes. 

For more details on configuring the server’s boot up function, 
refer to page 53.

Actions

The Actions menu consists of the following commands:

• Power On

Parameter Description

Retry times for 
system boot up 
failure (times)

Defines the number of times the system will be 
restarted when system fails to boot successfully. 
This parameter will force the system to reboot 
until the system boots up successfully or the 
retry value is reached. The default value is 0.

BIOS POST 
Timeout(min)

Enables the Watchdog Timer during system 
bootup.  This will set the internal time for the 
server’s POST to be completed. The default 
value is 5 minutes.

OS Load 
Timeout(min)

Enables the Watchdog Timer once OS is loaded 
to the server. This will set an internal time for 
loading the server’s OS. The default value is 10 
minutes.

The ASM (Acer Server Management) agent 
should be installed seperately in order to 
operate the OS Load Timeout function.  For  
instructions on installing the ASM agent, refer 
to the Acer Server Manager user’s guide.
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Remotely boot up a server.  You have two options:

For detailed instructions on remotely turning on the server, refer 
to page 54.

Enable BIOS Console Redirection

Enables BIOS console redirection during system boot up.  The Acer 
RDM software supports console redirection, in text mode, allowing 
you to remotely monitor and operate the server during boot up.

The console redirection command allows you to: 

• Remotely change the BIOS/CMOS/SCSI settings during the 
system’s POST process

• Boot the system from the floppy drive of the remote console

• Change the server’s BIOS or BMC firmware via a remote floppy 
drive

• Run the system diagnostic tools from a remote floppy drive 

You can enable console redirection in the Power On and Reset 
dialog box.  If you disabled this command, the Console On button 
on the Acer RDM window will be grayed-out.  

For details on enabling console redirection, refer to page 57.

Hot keys

RDM employs hot keys that allow you to remotely access the 
server’s BIOS/CMOS/SCSI settings, bootup function and diagnostic 
tools  from your computer.  

Parameter Description

Normal Boot Boots the server according to its CMOS 
(complementary metal-oxide semiconductor) 
startup settings.

Remote Floppy Boot Boots the server from the floppy drive of the 
remote console.
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Listed in the following table are the commonly used hot keys 
when RDM is in the Server Management  or BIOS Console 
Redirection (BCR) view mode.  

Hot keys 
(RDM in local mode) 

Key mapping
(RDM in BCR mode)

F1 <Esc>1

F2 <Esc>2

F3 <Esc>3

F4 <Esc>4

F5 <Esc>5

F6 <Esc>6

F7 <Esc>7

F8 <Esc>8

F9 <Esc>9

F10 <Esc>10

F11 <Esc>11

F12 <Esc>12

Home <Esc>@

End <Esc>h

Page Up Page Up

Page Down Page Down

Up Arrow Up Arrow

Down Arrow Down Arrow

Right Arrow Right Arrow

Left Arrow Left Arrow
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You can only activate the key mapping when the BCR Console On  
function is enabled and the BIOS Console Redirection (BCR) image 
is displayed on your computer screen.  

Remote floppy boot

Remotely updates the server’s BIOS settings and runs the server’s 
diagnostic program when BIOS Console Redirection is enabled.  
When you enable remote floppy boot function, the server will 
boot from the floppy drive of the remote console and at the same 
time automatically activate console redirection.  The server and 
console can share the same floppy drive until you disable the 
remote floppy boot function.

You can enable remote floppy boot function in the Power On and 
Reset dialog box.  For more information, refer to page 59.

• Power Off

Remotely turns off a server. 

For instructions on remotely powering off a server, refer to page 
55.

<Ctrl>+<Alt>+<Esc>
(Enter BIOS Setup)

<Esc>S

<Ctrl>+<Alt>+<Del>
(Warm Reset)

<Esc>R<Esc>r<Esc>R

<Ctrl>+A
(LSI SCSI Setup)

<Ctrl>+A

<Ctrl>+C
(LSI SCSI Setup)

<Ctrl>+C

<Ctrl>+M
(LSI SCSI Setup)

<Ctrl>+M

<Ctrl>+H
(LSI RAID-Web BIOS)

<Ctrl>+H

<Ctrl>+Q
(Storage)

<Ctrl>+Q

Hot keys 
(RDM in local mode) 

Key mapping
(RDM in BCR mode)
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• Reset

Remotely restarts a server. 

Please see “Remotely reset a server on page 56” for details.

• Clear Event Log

Deletes the server’s event log records.

For details on clearing the system event log, refer to page 63.

• BCR Console On/BCR Console Off

Allows you to toggle the view mode of the Acer RDM windows 
when BIOS Console Redirection is enabled.  View mode include 
Console redirection view and Server management view.  

The server status is indicated by the following conditions:

Please see “Setting the Acer RDM view on page 58” for details.

View 

The View menu consists of the following commands:

• System Information

Displays the server’s system information including those related to 
CPU, memory, mainboard as well as other server information.

Status Description

Grayed The server failed to boot up or the BIOS 
Console Redirection parameter is disabled. 

BIOS Console On The server’s BIOS Console Redirection 
parameter is enabled.  In this state, the BIOS 
Console Redirection status will be displayed on 
the Acer RDM window. 

BIOS Console Off The Server Management view mode is 
displayed on the Acer RDM window.
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The system information command includes the following 
parameters:

Please see “Viewing system information on page 60” for details.

• BMC Information

Displays the server’s baseboard management controller (BMC) and 
network information on the right panel of the Acer RDM window.

For detailed instructions on viewing the server’s BMC information, 
refer to page 61.

Information Description

CPU Information Displays the status, socket type, CPU 
manufacturer, CPU model and frequency of the 
processor installed on the server.

Memory Information Displays the memory slot status and memory 
module installed on the server. 

Server Board 
Information

Displays the BIOS version. It also shows the 
mainboard manufacturer, server model, serial 
number and part number.

Product Information Displays the server’s manufacturer, server 
model, serial number, asset tag, etc.

Information Description

BMC Board 
Information

Displays the BMC status, BMC firmware version, 
IPMI version, manufacturer, etc.

Network 
Information

Displays the server’s IP address, MAC address, 
and DNS settings. 
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• Event Log

Displays the event log information on the right panel of the Acer 
RDM server.  When you select the root server, all the servers’ event 
log information will be displayed. 

For instructions on viewing the event log, refer to page 63

• Tool Bar

Parameter Description

Event status The server status is indicated by the icons 
alongside each listed server.  

The status of the server may appear in the 
following conditions:

• Gray - An unknown event occurred in the 
server

• Green - Server is in a healthy state

• Yellow - Server warning status; the system 
administrator can choose to ignore or fix 
the error

• Orange - A critical error occurred in the 
server, the system administrator must fix 
the error to avoid system crash

• Red - A non-recoverable error occurs in 
the server, the system administrator must 
fix the error to avoid system crash  

For information on these icons, refer to page 
21.

Date/Time Displays the date and time when the event 
occurs.

IP Address Displays the server’s IP address.

Severity Displays the type of events detected - 
unknown, information, warning, critical and 
non-recoverable.

Description Displays a detailed description of the events.
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Displays or hides the Acer RDM toolbar.

• Grid Line

Displays or hides the grid lines on the right panel of the Acer RDM 
window.  Grid lines appear as criss-crossing horizontal and vertical 
lines on the screen.

• Status Bar

Displays or hides the Acer RDM status bar.

Help

The Help menu includes the following commands:

• Acer RDM Help

Opens the Acer RDM online guide which provides instant onscreen 
access to detailed information and instructions on how to use Acer 
RDM.

• About

Displays the copyright notice and version number of this 
application.

grid line
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Acer RDM toolbar
The Acer RDM toolbar buttons gives you one-click access to selected 
Acer RDM functions.  

Command Icon Description

Discovery/
Subnet/
Specific IP

Discovery- Automatically find a server on the 
network
Subnet- Manually find an Acer RDM-enabled 
server within a specific subnet
Specific IP- Manually find an Acer RDM-
enabled server based on a specific IP address

Refresh Displays a health status update of the servers 
listed on the left panel of the Acer RDM 
window.

Power On Remotely boots up a server

You must first select a listed server to enable 
this button.

Power Off Remotely turns off a server.

Reset Remotely restarts a server.

BCR Console 
On/Off

Shifts the view mode of the Acer RDM 
windows between Console redirection view 
and Server management view.

BMC NIC Displays the server’s BMC information.

Event Log Displays the server’s event log information.
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Exit Closes the Acer RDM program.

Command Icon Description
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Acer RDM view panels
The view panels refers to the left and right panels of the Acer RDM 
window.  The left panel displays the managed servers while the right 
panel displays found servers available for management.  Both panels 
are empty when you run Acer RDM for the first time.  You can discover 
a server by clicking the Discovery button, then the detected server will 
be displayed on the right panel of the Acer RDM window. 



 3 Getting started36

RDM.book  Page 36  Tuesday, September 10, 2002  11:43 AM



4  Configuring 
Acer RDM

RDM.book  Page 37  Tuesday, September 10, 2002  11:43 AM



This chapter describes how to configure the 
commands and functions of the Acer RDM 
program. 

RDM.book  Page 38  Tuesday, September 10, 2002  11:43 AM



39

RDM.book  Page 39  Tuesday, September 10, 2002  11:43 AM
Connecting to a server
When you connect to a server for the first time, you will be requested 
to enter the server’s password in the Login dialog box in order to 
browse and configure the server.  The default password is 
ADMIN@ACER. 

You can change the login password of a server after logon by selecting 
the Security option from the Setup menu.

If attempt to connect to the server has timed out or if Acer RDM is not 
logged into the server, you will be prompted to enter the server 
password again.  

Note:  The default period of interval for a connection attempt to 
time out is 10 minutes.
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Configuring Auto-Discovery
Auto-Discovery lets you add servers to the Acer RDM window for 

monitoring.  By clicking the Discovery button , Acer RDM will 
automatically detect existing servers available for management and 
display them on the left and right panel of the Acer RDM window.  You 
can configure the server by right-clicking a server then selecting a 
command on the pop-up menu.  Refer to the subsections below for a 
detailed discussion of these commands.

Add a server

Adds a server to the left panel of the Acer RDM window.

To add a server to Acer RDM:

1 Do either of the following:

• Click the Discovery button  on the toolbar. 

• Click the Server menu then select Auto-Discovery.  

The window below appears. 

The discovered server is displayed on the left and right panels of 
the Acer RDM window.  

Add All Servers

Adds all discovered servers to the left panel of the Acer RDM window.
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To add all servers to Acer RDM:

1 Select the server(s) you want to add then right-click the selection. 

2 Select All Servers from the pop-up menu.  

The servers you selected will appear under the Network tree 
structure on the left panel.

Delete Server

Removes a server from the right panel of the Acer RDM window.   If 
the selected server already exists on the left panel, it will also be 
removed.

To delete a server from Acer RDM:

1 Do either of the following:

• Select the server(s) you want to delete then right-click the 
selection. Select Delete Server from the pop-up menu.

• Select a server. Click the Server menu then select Delete.  The 
server will be removed from the left panel.

The server will be removed from the left and right panels of the 
RDM window.

Delete All Servers

Removes all the discovered servers from the right panel.  If the servers 
already exist on the left panel, it will also be removed.

To delete all servers from Acer RDM:

1 Do either of the following:

• Right-click the server(s) on the right panel then select Delete 
All Server.

• Select the server(s) you want to delete.  Click the Server menu 
then select Delete All Servers.

The servers will be removed from the left and right panels of the 
RDM window.
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Finding a subnet
Finds Acer RDM-enabled servers within a specific subnet. 

To find a subnet:

1 Click the Server menu then select Find Subnet.  The dialog box 
below appears.

2 Enter the IP address range you want Acer RDM to search and the 
timeout value.

3 Click OK.  



43

RDM.book  Page 43  Tuesday, September 10, 2002  11:43 AM
Finding specific IP
Finds Acer RDM-enabled server based on a specific IP address.

To find a server:

1 Click the Server menu then select Find Specific IP.  The dialog box 
below appears.  

2 Type in the server’s IP address.

3 Click OK.
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Configuring the Address Book
Address Book lets you maintain a list of Acer RDM-enabled servers.  
You can configure the Address Book using either the pop-up menu 
commands or the Server menu drop-down options.  Refer to the 
subsections below for a detailed discussion of these items.

Add 

Adds a server to the Address Book. When a server is discovered after 
RDM is launched, RDM will automatically add the server to the Address 
Book. You can also manually add servers to the Address Book.  To add 
a server to the Address Book, follow the procedures below:

1 Do either of the following:

• Right-click the server name on the right panel of the RDM 
window then select Add to Address Book. 

• Click the Server menu then select Address Book.  The Address 
Book window appears.  Click the Edit menu then select Add. 

• Click the Server menu then select Address Book.  The Address 
Book window appears.  Right-click the Address Book grid lines 
then select Add. 
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2 The Add dialog box appears.

3 Type the server’s IP address in the IP Address field.

4 Select Auto to display the server name in the Address Book or click 
Manual to enter a server name. 

5 Click OK.  

Modify

Modifies the server entries in the Address Book.

To modify a server entry in the Address Book:

1 Do either of the following:

• Select a server entry in the Address Book.  Click the Edit menu 
then select Modify.

• Right-click a server entry then select Modify. 

• Double-click a server entry then select Modify. 

The Modify dialog box appears.

2 Type in the new server name or IP address.
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Note:  If the server you want to modify already exists in the RDM 
window, the IP address field will be grayed-out.

3 Click OK.

Delete

Deletes a selected server(s) from the Address Book.

To remove a server(s) from the Address Book:

Do either of the following:

• Select a server(s) entry in the Address Book.  Click the Edit menu 
then select Delete.

• Right-click a server entry then select Delete. 

• Select a server(s) entry in the Address Book then press the Del key.

Discovery

Detects a selected server in the subnet. 

To discover a server:

Select a server then click the Discovery button.  If the selected server is 
a RDM-enabled server, it will be appear on the RDM window. 
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Changing the server name
Modifies the name of the server.  

Note:  You can not change the server name when the login 
password has not been validated.

To change the server name:

1 Click the Server menu then select Change Server Name.  The dialog 
box below appears.  The current name of the server is displayed in 
the server name field.

Note:  The maximum length for a server name is up to 32 
alphanumeric characters.

2 Type in a new server name.

3 Click OK.
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Refreshing the server’s health status
Displays an updated health status of the servers listed on the left panel 
of the Acer RDM window.  The server status is indicated by the icons 
alongside each listed server.  For details on the server status icons, refer 
to page 21.

To refresh server’s status:

Do either of the following:

• Click the Refresh button  on the toolbar.

• Right-click the left panel, click the Server menu then select 
Refresh.
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Configuring the BMC NIC
Configures the out-of-band network interface controller (NIC) of the 
server.  This allows you to manage the LAN port and the NIC settings on 
the server.

To configure the BMC NIC setting:

1 Click the Setup menu then select BMC NIC.  The dialog box below 
appears.

2 Fill out the different fields. 

3 Click OK.
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Sending an email alert
The server sends an email alert to the system administrator when a 
critical system event is detected.

To send an email:

1 Click the Setup menu then select E-Mail.  The dialog box below 
appears.

2 Fill out the email fields.

3 Click OK. 
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Enabling email notification
By default, the Email Notification function is disabled.  You have to 
enable this function in order to receive email notification from the 
server whenever a critical system event or an error occurs.  For details 
on system events, refer to page 23.

To enable email notification:

1 Click the Setup menu then select Event Filter.  The dialog box 
below appears:

2 Select the Enable E-Mail Notification checkbox. 

3 Select an event type(s) then click < or << to transfer it to the 
Enabled column.

4 Click OK.
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Changing the server password
To change the server pasword:

1 Click the Setup menu then select Security.  The dialog box below 
appears.

2 Type the old password in the Admin Old Password field.

3 Type a new password in the Admin New Password field then 
retype it for confirmation.

4 Click OK.
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Configuring the automatic system 
recovery function
To configure the automatic system recovery function:

1 Click the Setup menu then select Automatic System Recovery.   

2 Select the number of retry times for system bootup failure. 

3 Set the BIOS/POST timeout limit.

4 Set the OS Load timeout in the Watchdog Timer Settings.

Note:  The ASM agent should be installed seperately in order to 
operate the OS Load Timeout function.  For  instructions on 
installing the ASM agent, refer to the Acer Server Manager user’s 
guide.

5 Click OK. 
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Remotely turning on a server
To remotely turn on a server:

1 Select a server on the left panel of Acer RDM window.

2 Click the Actions menu then select Power On.  The dialog box 
below appears. 

3 Select a start up option.

Select the Enable BIOS Console Redirection check box if you want 
to enter the BIOS Console Redirection mode .

4 Click OK
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Remotely turning off a server 
To remotely turn off a server:

1 Select a server on the left panel of Acer RDM window. 

2 Click the Actions menu then select Power Off.  The dialog box 
below appears.

3 Click OK.

The Confirm Power Down dialog box appears.  Click OK to turn off 
the server.
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Remotely reset a server
To remotely reset a server:

1 Select a server on the left panel of Acer RDM window. 

2 Click the Actions menu then select Reset.  The dialog box below 
appears.

3 Select a start up option.

4 Click OK.
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Enabling console redirection
To enable console redirection:

1 Do either of the following:

• Click the Actions menu then select Power On.

• Click the Actions menu then select Reset. 

2 Click the Enable BIOS Console Redirection check box.

3 Click OK.
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Setting the Acer RDM view
You have the option to set how the Acer RDM window appears when 
the BIOS Console Redirection function is enabled.  The options include: 

• Console Redirection view 

To view in Console Redirection mode:

Click the Actions menu then select BCR Console On. 

The BIOS Console Redirection image will be displayed on the Acer 
RDM window.

• Server Management view

To view in Server Management mode:

Click the Actions menu then select BCR Console Off. 

The Server Management view mode is displayed on the Acer RDM 
window.
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Enabling remote floppy boot function
To enable remote floppy boot:

1 Do either of the following:

• Click the Actions menu then select Power On.

• Click the Actions menu then select Reset. 

2 Click the Remote Floppy Boot radio button.

3 Click OK.
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Viewing system information
Displays the server’s system information including those related to the 
CPU, memory, mainboard as well as other server information.

To view the system information:

1 Select a server from the Network tree structure on the left panel of 
the Acer RDM window. 

2 Click the View menu then select System Information.  The window 
below appears.
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Viewing BMC information
Displays the server’s BMC and  network information.

To view the BMC information:

1 Select a server from the Network tree structure on the left panel of 
the Acer RDM window. 

2 Click the View menu then select BMC Information.  The window 
below appears.
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Viewing hardware status information
Displays the server’s hardware status, including those related to the 
chassis, fan, temperature and voltage sensors.

To view the hardware status information:

1 Select a server from the Network tree structure on the left panel of 
the Acer RDM window. 

2 Click Hardware Monitor.  The window below appears.

Parameter Description

Chassis Intrusion Displays the chassis intrusion: opened or closed.

FAN Sensors Displays the fan status and current speed 

Temperature Sensors Displays the CPU and system temperature.

Voltage Sensors Displays the voltage status.
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Viewing the event log
Displays the event log of a server.  When you select the root server, all 
the servers’ event log will be displayed.

To view the event log:

1 Select a server from the Network tree structure on the left panel of 
the Acer RDM window. 

2 Click the View menu then select Event Log. The window below 
appears.

Clearing the event log

To clear a server’s event log:

1 Select a server on the left panel of the Acer RDM window. 

2 Click the Actions menu then select Clear Event Log. 
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